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Research Writing Guide
Sparkman High School English Department


What Is the Purpose for Research Writing?
· The Alabama State Course of Study for English Language Arts requires that students “use the research process to manage, document, organize, and present information to support a thesis” on a teacher-approved topic (“ALEX”).

· The National Council for Teachers of English states that students should “gather, evaluate, and synthesize data from a variety of sources” (“NCTE”).

· Students should also use available technology (databases, word processing, educational Internet sites, videos, libraries, etc.) to manage, document, organize and present their research.

· Students should write an original, well-documented, well-organized research paper using MLA format.  The length will be determined by the teacher.

· Students should use a variety of resources to compose a strong, thorough research paper.
· Students should use proper grammar and mechanics in composing the paper.

· Students should demonstrate varied sentence structure.

· Students should demonstrate appropriate use of tone and language for academic writing.

· Students should use powerful, expressive, and appropriate word choice.

Plagiarism and How to Avoid It

· Plagiarism is a form of cheating that involves taking ownership or authorship of a work product that is not your own.

· MLA states that plagiarism includes two kinds of wrongs.

· The first is “using another person’s ideas, information, or expressions without acknowledging that person’s work” (66).

· The second is “passing off another person’s ideas, information, or expressions as your own to get a better grade or gain some advantage constitutes fraud” (66).

· It is critical that when you use another person’s ideas, information, or expressions that you give the source credit, EVEN IF YOU PARAPHRASE OR SUMMARIZE THE MATERIAL (Gibaldi 69).

· Be aware that if you use the author’s exact wording without the use of quotation marks, you have plagiarized, EVEN IF YOU CITE THE MATERIAL (Gibaldi 70).

· One should also realize that the absence of citations and/or a works cited in a research paper constitutes plagiarism because one has still not credited the appropriate sources.

· There are four rules that you can follow to avoid plagiarism (Kleppner 8).
· If a fact is not common knowledge, it must be cited.

· For our purposes, common knowledge is something that most people in our society would know.

· The Incas used stone to build roads, bridges, fences, and weapons (McIntyre 37).
· Though you do not have to cite your own ideas, you do have to cite the ideas of others, even if you paraphrase or summarize.
· Example of student observation:  Much of the literature in America during the early nineteenth century contained lonely characters.

· Though priests and missionaries tried to convert the Chipaya Indians, they resorted to their pagan ways (McIntyre 88).

· When you use someone’s exact words, you must do two things.  You must put them in quotation marks, and you must cite the quotation.  The absence of quotation marks AND a citation is plagiarism.

· One historian states, “Bone-crushing weapons of war—combined with skilled tactics, shrewd diplomacy, and an awesome reputation—aided Inca armies in the conquest of such powerful foes as the Chimu nation of Peru” (McIntyre 93).

· When you use another person’s ideas or information, you must put them into your own words.  You CANNOT simply rearrange or change a few of the author’s words.  In addition, you should cite the source.

· Original statement:  “By any definition, he was a peculiar little man.  He had a high-pitched voice, clothes that were too fine by most local standards, and he was bookish.”
· UNACCEPTABLE PARAPHRASE:  One critic said that Truman Capote was a peculiar little man by any definition. He had a high-pitched voice, and his clothes were far too nice by most local standards.  Capote was also bookish (Marshall A7).

· Even though the information is cited, not enough material was paraphrased. 

· ACCEPTABLE PARAPHRASE:  One critic describes Truman Capote as a strange little man.  Capote’s high-pitched voice, fancy attire, and bookish nature also made him stand out among the locals (Marshall A7).
· If you are unsure whether to cite your information, then cite it to be safe!

· IMPORTANT REMINDER:  The whole paper should not be cited.  You do not cite every sentence.  Though you may have a citation in each paragraph, you should also remember to include your own thoughts, ideas, and analysis.  However, your thoughts, ideas, and analysis should connect with the research material.

MLA Format

What is MLA style?

MLA style is a system used in English classes that guides your research, your writing, and your documentation.  This style was designed by the Modern Language Association of America.  

· Font

· Use size 12 font throughout all components (the paper, the works cited, the outline, the heading…)
· Use Times New Roman font unless instructed otherwise by your teacher.
· Margins
· MLA says that all margins should be one inch.
· If you have Microsoft Word 1997-2003, the following directions will help you to change your margins.
· Begin a new Word document.
· Click on “File.”  This is located at the top of the screen on the far left.
· Scroll to “Page Setup.”  Click on “Page Setup.”
· The first tab contains your margins.  Make sure the top, bottom, left, and right margins are set to 1”.
· If you have Microsoft Word 2007, the following directions will help you to change your margins.
· Begin a new Word document.
· At the top of the page, click the “Page Layout” tab. 
· Toward the left side of the screen is the “Margins” button. Click this button.
· Scroll to normal. Click normal.
· This will set all your margins to one inch.
· Page Numbers
· MLA states that you should number your pages with your last name, followed by the page number.  This is located on the right side of the paper, and it is ½” from the top of the page.
· To insert a MLA style header using Microsoft Word 1997-2003, follow the instructions below.
· After setting your margins, click on “View.”  This is located at the top of the screen on the left side of the screen.
· Scroll to “Header and Footer.”  Click on “Header and Footer.”
· A box will appear at the top of your page, and a toolbar will be in the middle of your screen.
· Toward the left side of that toolbar, there will be a button with “#” on it.  Click that button.
· You will see a page number in the top, left hand corner of your screen.  It will probably be gray in color.
· Double click on the number.
· Now look at the formatting toolbar.  This is the toolbar that contains your font, font size, bold, italics, underline, and justification buttons.
· In the middle of the screen you will see a button that will allow you to ‘align right’.  If you are unsure which button it is, let your mouse hover over the button until you find the button that allows you to align on the right side of the paper.
· Click “Align Right.”
· Now, before the page number, type in your last name.  
· Your page numbers will appear on all the pages you type.  You do not have to repeat the process for each page.
· To insert an MLA style header using Microsoft Word 2007, follow these instructions.
· At the top of the page, click on the “Insert” tab.
· In the middle of the page there is a button that says “Page Number” in the Header and Footer box. Click the “Page Number” button.
· Scroll to “Top of Page”; scroll to “Plain Number 3”; click on “Plain Number 3.” The page number will appear at the top right of your screen.
· Type your last name in front of the page number.
· This header will appear on all pages of your paper, and you do not have to repeat this process after the first page.
· Spacing

· Your paper should be double spaced throughout.   
· There is no need for extra spacing anywhere in the paper.  
· Your heading is double spaced.
· Your works cited pages is also double spaced.
· If you have Microsoft Word 1997-2003, use the following instructions to double space your paper.
· After you have set your margins and page number, you should complete the following steps to change your line spacing.
· At the top of the page, click “Format.”
· Scroll down to “Paragraph.”  Click on “Paragraph.”
· A box will appear on your screen.  In the middle of the box, there is a drop down menu labeled “Line Spacing.”  Click to display the drop down menu.  
· Choose “Double.”
· Click “OK.”
· If you have Microsoft Word 2007, use the following instructions to double space your paper.
· After you have set your margins and page number, you should complete the following steps to change your line spacing.
· Find the “Home” tab at the top of the page.  Click on the “Home” tab.
· In the middle of the page at the top, double click on the arrow to the right of the word “Paragraph.”
· A box will appear on your screen.  In the middle of the box, there is a drop down menu labeled “Line Spacing.”  Click to display the drop down menu.  
· Choose “Double.”
· Click “OK.”
· Heading

· MLA states that you should have a heading at the top of the first page of your paper. The heading should include the following information: author’s name, the name of the teacher for whom you are writing the paper, the name of the class for which you are writing the paper, and the date the paper is due. The information must appear in this order. This information should appear at top of the first page on the left hand side of the paper. 
· MLA stipulates that dates must be formatted in a certain way. The date for an MLA paper should begin with the day of the month, followed by the month and then the year.
· For example, for a paper turned in on May 20, 2008, the date should be formatted as follows:
· 20 May 2008 
· The heading takes the place of a cover page.  It is not necessary to do a cover page.
· Title
· Your title goes on the line below the date.
· The title should be centered.
· The title should NOT be in bold or underlined.
The following is an example of the top of the first page of an MLA style paper.

Quotations
Quotations are a necessary part of a well-supported paper, but they must be correctly formatted and used sparingly.

The following are some tips on formatting your quotations:

· You must introduce your quotes.  The following are examples of how to begin a sentence that will include a quotation.

· According to William Jackson,…

· One critic states, …

· One author claims, …

· If the material you want to quote is a quote, use the following example:

· She stated, “‘This was a very critical decision.’”

· The set of three quotation marks indicates that you are quoting material that was quoted in your source.

· If you have a quote that is more than four typed lines (when you type it out), this quote must be in a free-standing block.  Indent the block ten spaces.  Also make sure that the citation is after the period, and you do not enclose the quote in quotation marks.

· The following is an example of how to set up a long quotation.

In-Text Citations

What is the purpose of in-text citations?
Every time you borrow material, you must give credit to the source.  Whether you paraphrase, summarize, or quote the material, you must cite it to avoid plagiarism.  

Where do you put the citation?
The citation usually appears at the end of the sentence.  When placed at the end of the sentence,  place it before the period at the end of the sentence.  When you use material from the same source and the same page numbers throughout a paragraph, you may use one citation at the end of the paragraph instead of citing after each borrowed sentence.  In some cases, a partial quote for example, you may need to use a citation immediately after the material quoted.  Thus, in such case, the citation would be within the sentence, not at the end.
What information belongs in the in-text citation?

Typically, you will use the author’s last name and the page number where the information was found.  However, not all material will have an author, an encyclopedia for example.  In addition, some sources do not have page numbers.  For example, most online documents will not have page numbers.  (Those documents in PDF format are usually the exception.)  The following examples should help you.
Examples

If your source has an author and a page number, you should refer to the following examples to format your citations.

Example A:  Maya Angelou’s parents divorced in 1931, and her mother sent Angelou and her brother to live with their grandmother in Stamps, Arkansas (Kite 11).
· Kite is the name of the author, and the information is located on page 11.  

· Notice the absence of quotation marks.  This means that the student paraphrased or summarized the material.

· Do not use a comma between the author’s name and the page number.

· You should not include pp. or pg. to indicate page number.  

Example B:  According to L. Patricia Kite, Maya Angelou’s parents divorced in 1931, and her mother sent Angelou and her brother to live with their grandmother in Stamps, Arkansas (11).

· Since the student mentioned the author’s name in a signal phrase that introduced the information, there is no need to repeat the author’s name in the citation.

· Again, the absence of quotation marks indicates that the material is paraphrased or summarized.

If your source has an author but no page number, then you should refer to the following examples to format your citations.

Example A:  Mrs. Flowers eventually helped restore Angelou’s speech and pushed her to be a more confident individual (Burt).
· In this example, the student gives the author’s last name in parentheses at the end of the sentence.  

· There is no page number because the material is from an online source.

· This material is summarized or paraphrased.  We know that because of the absence of quotation marks.

Example B:  According to Sharon Burt, Mrs. Flowers eventually helped restore Angelou’s speech and pushed her to be a more confident individual.
· In this sentence, the student used a signal phrase to cite the author of the information.  

· If you cite the information in a signal phrase, there is no need to mention the author’s name again in a parenthetical citation.

· We know this material is paraphrased or summarized because of the absence of quotation marks.

If your source has no author and no page number, then you should refer to the following examples to format your citations.  In addition, please be aware that most credible information will give credit to an author, so be leery of sources with no author.

Example A:  The reading of her poem “On the Pulse of the Morning” was broadcast around the world (“Maya”).

· Since this source has no author, the student puts a shortened version of the title in quotation marks at the end of the sentence.

· You do not have to put the whole title, just a shortened version.  However, you should you keywords from the title that will allow readers to identify with certainty the source from your works cited to which you are referring.

· This material is summarized or paraphrased.
Works Cited Entries
What is the purpose of a works cited page?

A works cited page (formerly known as a bibliography) is necessary so that others reading your paper will be able to find the materials that you used when researching your paper.  The information is organized in a specific way that would allow a reader to have all the necessary information to find your sources.  In addition, the sources included on your works cited page should match the sources that you cited in your paper.
What sources do I include in my works cited?
Though you may examine twenty sources when beginning your research, chances are all of the material you read will not be useful.  Therefore, you only cite the material that you use.  The reason this document is called a “Works Cited” is because you are citing, or giving credit to, the works or materials that you use.  
How do I format my entries?

This may be one of the most detailed parts of the paper.  You format your entry based on the information you have about your source.  Many examples are included below.  In addition, you may look at the works cited page included at the end of this handbook to see how a completed works cited page looks.

How do I organize my entries?

· At the top of the page in the center, title the page Works Cited.  This title should not be in bold or underlined, and do not put it in a larger font.

· The entries are organized alphabetically by the first word of the entry.  
· In addition, the works cited page is double-spaced throughout, just like the body of the paper.  
· The first line of each entry begins at the margin; however, subsequent lines must be indented one-half inch.  (You may use the tab key for convenience, or you may set the hanging indent.)

Where do I put my works cited?
Your works cited should be the last page of your paper, and it should be numbered as the last page of your document.  At the end of the paper, if you hit “CTRL” + “ENTER,” you will automatically begin a new page for your works cited.  Remember, since this is the last page in your document, all of the formatting (font, font size, spacing, page number, and margins) should be the same as the paper.

Example Entries

Note:  The following examples come from a variety of sources, including the MLA Handbook and actual student papers.  In addition, some entries were made up

Books

One Author

Donnelly, Peter. The People's Princess. Philadelphia: Sweetwater, 1997.
This entry begins with the author’s name, last name first, followed by the title of the book.  Please note that MLA requires you to underline book titles rather than put them in italics.  After the title, include the place of publication.  Then include the publisher.  Do NOT include words like “Company” or “Inc.” after the publisher’s name.  This is a shortened version of the publisher’s name.  The last thing included in the entry is the most recent publication date.  Take note of the punctuation and follow the pattern exactly.
Two or Three Authors
Eggins, Suzanne, and Diana Slade.  Analyzing Casual Conversation.  London:  Cassell, 1997.

The only thing different about this entry is that first author is listed last name first, and other authors are listed first name first.  You do not have to list authors within the entry in alphabetical order.  Actually, you should list the authors in the same order as on the title page of the book.
Four or More Authors
Smith, JoAnne, et al.  Reliving the Experience.  Boston:  Wilhite, 1992.
If you have four or more authors, give only the first name followed by a comma and “et al,” a phrase which means “and others.”

An Encyclopedia or Dictionary

“Abraham Lincoln.”  Encyclopedia Americana.  1994 ed.
Usually, these sources do not have authors, but if the source does have an author (or authors), provide that information. 

Two Works by the Same Author
Palmer, William J.  Dickens and New Historicism.  New York:  St. Martin’s, 1997.

---.  The Films of the Eighties:  A Social History.  Carbondale:  Southern Illinois UP, 1993.

Both of these works are written by William J. Palmer.  In addition, you might notice the “UP” in the publisher’s name in the second entry.   This is the abbreviation for “University Press”.

Periodicals in Print

Magazine Article
Wesson, Charles.  “Reexamining the Past.”  Newsweek 12 June 2001:  16-18.

Notice that there is not a period after the title of the magazine.  In addition, the numbers included at the end of the entry are the page numbers.

Newspaper Article
Harris, Nicole.  “Airports in the Throes of Change.”  Wall Street Journal  27 Mar. 2002:  B1+.

Notice that there is no period after the title of the newspaper.  The “+” after the B1 indicates that this article continued on other pages; however, as is common in newspapers, the article was continued much later in the section.  For example, the rest of the article might be on B7.

Electronic Sources
A Website

Citing websites can be tricky because not all websites contain all the same information needed in a citation.  Below is a generic citation.  You should include all of the available information in the citation.

Author’s last name, first name.  “Article title.”  Title of Website.  Name of Page.  Date of Posting/Revision/Update.  Name of institution/organization affiliated with the site.  Date of access <URL>.

The following are actual examples:

 “iTunes Music Store Begins Countdown to 100 Million Songs.” Apple. 1 July 2007. 
<http://ww.apple.com/pr/library/2014/jul/01itunes.html> 

Princess Diana and the Mines Campaign. 24 March 2008. 20 March 2008 
<http://www.canadianlandmine.org>.
Celizic, Mike. "Time for Steroid Testing in High School." msnbc.com. 24 Apr. 2004. 28 Oct. 2007 <http://www.msnbc.msn.com/id/4556250/>.  

Burt, Sharon. “Maya Angelou.” VG: Artist Biography.  Ed.Lauren Curtri.4 Aug. 

2004. 20 Feb. 2008 <http://voices.cla.umm.edu>.


An Article from an Online Database
The use of online databases is becoming more popular because you can find a large amount of quality credible material very quickly.  If you used a database (like Academic Search Premier on AVL), the following examples should be helpful.

Baym, Nina.  “The Head, the Heart, and the Unpardonable Sin.”  The New England Quarterly 

40.1 (1967):  31-47.  JSTOR.  JSTOR. Collier Lib.  Florence, AL.  22 Feb. 2008. 

McCullen, Joseph T., and John C. Guilds.  “The Unpardonable Sin in Hawthorne:  A Re-

Examination.”  Nineteenth-Century Fiction 15.3 (1960):  221-37.  JSTOR.  JSTOR. 

Collier Lib.  Florence, AL.  22 Feb. 2008.

Kelly, Alice. “Stay Safe in the Sun.” Natural Health 36 (2006).   EBSCO. Alabama Virtual 
Library.  Sparkman High School Lib. Harvest, AL.  3 October 2007.

The following is a generic example:

Author’s last name, first name.  “Title of the article.”  Title of the Journal Volume.Issue (Year):  

pages.  Database name.  Service name.  Library Name.  Library Location.  Date retrieved.
Works Cited
Alabama State Department of Education.  “Course of Study.”  Alabama Learning Exchange.  7 May 2008.  <www.alex.state.al.us>.

Gibaldi, Joseph.  MLA Handbook for Writers of Research Papers.  New York:  MLA, 2003.

Kleppner, Amy M.  Research Paper Procedure.  Teacher’s Discovery, 2004.

Marshall, Mitchell.  “Capote’s Arrival Always a Splash.”  Decatur Daily.  26 Feb. 2006:  A1+.
McIntyre, Loren.  The Incredible Incas and Their Timeless Land.  Washington, D.C.:  National Geographic, 1975.
National Council for Teachers of English.  “Standards for the English Language Arts.”  National Council for Teachers of English.  <www.ncte.org>.
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The Legend of a Hero, King Leonidas of Sparta


Many people view a hero as a virtuous and sensible person who is 


responsible for great change, either in his lifetime or beyond their own 


life. This very statement embodies King Leonidas. His life was made short 


by the sacrifices made for his people and country.








Ethan Brand sought to discover the unpardonable sin, and even when he finds it, he does not find contentment.  What he has learned has clearly changed him in a negative way.  Before his death, Brand sits by the fire recounting the change that has taken place within him.  The narrator states, 


Then ensued that vast intellectual development, which, in its progress, disturbed the counterpoise between his mind and heart…it had raised him from the level of an unlettered laborer to stand on a starlit eminence, whither the philosophers of the earth, laden with the lore of universities, might vainly strive to clamber after him…he was now a cold observer. (Hawthorne 310-11)   


Clearly, Brand fits Hawthorne’s description of the intellectual sinner because he suffers a separation between the mind and the heart.  Even Brand can reflect and see that this separation is a destructive division.  Miller claims that Brand is “obsessed with the desire of discovering the unpardonable sin” and during his search, he “cultivates his intellectual powers” to the point that he no longer fits in with the common man (95).  He sees himself as intellectually superior, even though there is no reason to believe that Brand possesses such superiority.











